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Introduction

As an Air Traffic Control Specialist (ATCS), you are in charge of all air
traffic in your sector. You are seated at the controls of a sophisticated
Air Traffic Control Simulator. For guidance equipment, you have a radar
screen, status panel, command panel, shift clock, wind direction
indicator, and turn timer. This manual provides instructions for the use
of these instruments, and for the operation of the simulator.

Each day, the lives of thousands of passengers lie in the balance of
your skill, judgment, and experience. It is your job to guide all of the
aircraft safely on course through your sector to their destinations. There
IS no margin for error.

Good luck.

Note: The following instructions assume a working knowledge of the
Macintosh Finder (i.e. clicking, dragging, etc.). If you find the
procedures described below confusing, please refer to your Macintosh
owners manual.

Backing Up

To back up your Near Miss disk, boot your Macintosh system and insert
a blank disk into one of your drives. Format the disk as single-sided.
Eject the newly formatted disk (if you have only one disk drive) and
insert the Near Miss program disk into the drive. When the Near Miss
disk icon appears, drag it onto the icon of the disk you formatted earlier.
Follow the on screen prompts and your program disk will be copied. Put
your original program disk away in a safe place and use your back up.

Hard Drive Installation

To install Near Miss on your hard drive, boot your Macintosh from the
hard drive. Insert the Near Miss program disk into a drive. When the
Near Miss disk icon appears, drag it onto the hard drive icon. This will
copy all the files on the Near Miss program disk into a folder on your
hard drive.




Getting Started

Insert the Near Miss diskette into the internal disk drive of your
Macintosh Computer. Double-click on the “Near Miss 1.0” icon to
initiate the program. All of the simulation options have been pre-set to
the beginner level. To get started, choose “With New Schedule” under

the “Simulate” menu, and you are ready to begin.

The Radar Screen

Figure 1 provides a detailed diagram of the radar screen:
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The radar screen shows the positions and headings of all aircraft that
are currently in the air in your sector. If two or more aircraft are at the
same location, only one will appear on the radar screen.

The space between dots on the radar screen is the distance a jet plane
travels during one 15 second turn. A propeller plane travels the same
distance in two turns, and a helicopter requires four turns. Propeller
planes are twice as fast as helicopters, and jets are twice as fast as
propeller planes.

The “Turn Timer” located in the lower right corner of the radar screen
counts off the 15 seconds between turns. The Turn Timer displays the
amount of time remaining before the next aircraft move. The “Shift
Clock” in the upper right corner of the radar screen displays the time
remaining in your shift.

The radar screen also shows all airports in the sector. Airports are
numbered from 1 to 5. The airport headings indicate the direction that
aircraft must use for landings and takeoffs.

Aircraft enter and exit at any one of the eight compass points on the
radar screen (N, S, E, W, NE, NW, SE, SW) or at one of the airports.
When entering from a compass point, the heading is directly toward the
center of the radar. When leaving from a compass point, the heading
must be directly away from the center of the radar.

When leaving from an airport, the aircraft will take off in the direction of
the airport. When landing, the aircraft must land from the direction of
the airport, or it will crash. (Note that helicopters may land from any

direction.)

In addition to airports, the radar screen shows all obstacles, which
include restricted areas, hills, towers, and thunderstorms.
Thunderstorms move in the direction of the wind, which is shown in the
wind direction instrument. The altitude levels for hills and towers are
shown on the screen.

Whenever an aircraft is on course for its destination, it is highlighted
compared to those aircraft that are not yet on course:
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Air Traffic Schedule Panel

The Air Traffic Schedule Panel displays one row of information

for each aircraft, with eight columns of data. This information is
summarized below, and in the Quick Reference Card that accompanies
Near Miss. Figure 2 shows a sample Schedule Panel, which is
described in detail below:

Column 1 Aircraft Status Symbol

Column 2 Aircraft Type

Column 3 Aircraft Heading and Altitude
Column 4 Commanded Heading and Altitude
Column 5 Entry Point

Column 6 Exit Point

Column 7 Remaining Fuel

Column 8 Entry Time
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Aircraft Status The 1st column uses symbols to show the current
status of the aircraft:

i Aircraft not yet in your sector

i Aircraft in the air, under your control, and OK
i Aircraft at airport and ready for takeoff

e Aircraft in the air and involved in a near miss
“=" Aircraft on course for scheduled exit

" Aircraft on course, but involved in a near miss

Aircraft Type The 2nd column uses one character to show the aircraft

type:
“J" Jet Plane
“P° Propeller Plane
“H” Helicopter

Current Heading and Altitude The 3rd column gives the current
heading (N, S, E, W, NE, NW, SE, SW) and altitude (0-8000 feet) for
aircraft under your control. This indicator is blank for aircraft that are
not yet in your sector.

Commanded Heading The 4th column lists the heading and altitude
to which you have commanded the aircraft. This column is blank when
the current heading and the commanded heading and altitude are the

same.

Entry Point The 5th column lists the entry point of the aircraft on the
radar screen. The entry point will be either a compass point and
altitude (NES; enter from NE at 5000 feet) or an airport from which the
aircraft will leave (AP2; airport #2).

Exit Point The 6th column shows the scheduled point to which the
aircraft must be directed. The exit point will be either a compass point
and altitude on the radar screen, or an airport.

Remaining Fuel Once an aircraft is under your control, the 7th
column shows the amount of time remaining in which the aircraft must
reach its exit point. If late, the aircraft will run out of fuel before reaching
its ultimate destination. This column is blank until the aircraft has
entered your sector.

Entry Time The 8th column shows the amount of time remaining, in
minutes and seconds, until the aircraft enters your sector or is ready to
take off from an airport. This column is blank after the aircraft arrives in
your sector.




Preview Aircraft

To preview the aircraft scheduled to enter your sector during the next
minute, place the cursor along the perimeter of the radar screen near
the compass point of interest (the cursor will change to concentric
rings), and hold down the mouse button. Figure 3 illustrates the data
window that appears:
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Communicating With an Aircraft

The Aircraft Control Commands, described below, allow you to issue
orders to specific aircraft. In order to issue these commands, you must
first establish direct communication with an aircraft by selecting it.

There are two methods for selecting an aircraft: 1) Use the mouse and
click on the icon of either the aircraft or airport on the radar screen, or
2) click on a line on the air traffic schedule.

If a position on the radar screen is selected that contains multiple
aircraft, they will all be highlighted on the air traffic schedule. However,
the control commands are only active when a single aircraft is selected.




Aircraft Heading Commands

Once you are in communication with an aircraft, you may issue
commands to alter its heading and altitude. Figure 4 illustrates the
panel with which you issue commands to aircraft. To issue a command,
position the cursor over the appropriate button, and click the mouse.
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Figure 4

The heading commands allow turns of 45, 90, 135 and 180 degrees to
the right or left relative to the current heading of the aircraft. Aircraft
turn at a rate of 45 degrees per move, and move at their initial heading
before turning. For example, an aircraft turning 90 degrees will move
straight, turn 45 degrees, move straight again, and turn 45 degrees:

(Fig. 5)
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The “A”" command causes an aircraft to cancel all turns and continue
straight at its current heading.

The “==" command causes an aircraft to circle. This command can only

be issued to aircraft that are already turning. The current direction of
turn determines the circling direction.

Aircraft Altitude Commands

The altitude commands instruct an aircraft to change to a specified
altitude between 0-8000 feet. Aircraft ascend or descend at a rate of

1000 feet per move on the radar screen. Aircraft begin to change
altitude immediately after receiving your commands.




Landing and Take Off

The “L” command causes an aircraft to land at its destination airport
when its path crosses the airport. The command is active when an
aircraft is at or commanded to an altitude of 1000 feet, and is cancelled
by issuing any other command to the aircraft. Commanding an aircraft
to zero feet will also land it.

When leaving from an airport, the aircraft will take off in the direction of
the airport arrow. When landing, the aircraft must land from the
direction of the airport, or it will crash. (See Figure 6). Note that
helicopters can land from any direction.
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Aircraft take off from an airport when you issue a command to ascend
to 1000 feet, or higher.

Simulation Options

You may select eleven game options that dramatically alter the difficulty
and realism of the program. These options are:

¢ Number of Aircraft In Your Schedule

e Amount of Time In Your Shift

e Number of Airports in Your Sector

e Required Aircraft Altitude Separation (for near miss)
* Required Aircraft Distance Separation (for near miss)
 Number of Hill Obstacles

* Number of Tower Obstacles

» Size of Restricted Flight Area

e Current Weather Conditions

* Whether Propeller Planes Are Included in Schedule
* Whether Helicopters Are Included in Schedule
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Figure 7 shows the dialog box that opens when you select “Set
Options.” Notice that as you increase the difficulty and realism of the
simulation, you increase the potential points per plane that you can
achieve. After you have selected the game options, press “Done”, or
“Save Options.” “Save Options” will store your net settings as default
settings. You may change your settings at any time, and re-save them.
“Print Screen” will print the contents of the screen.
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Simulate Menu
The Simulate menu presents the following commands:

* With New Schedule
* With Current Schedule
¢ End Simulation

“With New Schedule” creates a new schedule with the current
simulation options that you have selected, or with the current default
settings. “With Current Schedule” uses the same schedule used in the
most recent simulation or “Load Schedule” command.

When a simulation is started, the airline schedule for your shift is
shown in the Air Traffic Schedule Panel. You must direct each aircraft to
its assigned destination without crashing it, and must minimize the
number of near misses and hazards in order to maximize your score.

While playing, only the “End Simulation” option is available. Selecting
“End Simulation” terminates the current simulation, and allows you to
begin a new game, or play back your last game.

Clicking the small “Pause” box to the upper left of the radar screen
suspends the game without penalizing your score. While in Pause
mode the radar screen changes into a bulls eye. Click “Continue” to
resume play.

High Score Display

Selecting the “Show High Scores” item from the options menu will
display the 10 highest scores achieved. If you achieve a score in the top
10, you will be asked to enter your name and your score will be included
on the list. The “Clear Scores” command allows you to clear the list.
Only positive scores are saved. “Print Screen” prints the contents of
the screen.
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Play Back Last Game

The “Playback Last Simulation™ option will replay the last game
allowing you to analyze your performance during the last season.
During play back, aircraft that did not reach their assigned exit points
are not highlighted, so that you can concentrate on those aircraft.

To speed up the simulation, click on the Shift Clock in the upper right
corner of the Radar Screen, or the Turn Timer in the lower right corner
to advance the clock. The Pause box can be used to stop the clock
without obstructing the radar screen while in the play back mode.

Clicking on any control in the Control Panel will give you a chance to
take over and finish the game. This allows you to recover from any fatal
errors that you make. In this regard, Near Miss is far more forgiving
than the real thing, in which there is no margin for error.

Each time you playback a simulation, a 1% penalty is imposed on your
final score. If you play back 5 times, each time avoiding a new problem
to improve your performance, your score will be 95% of what it would
have been, if you had played the game from the beginning.

Toggle Conflict Blinking

When an aircraft is in a conflict situation, it will blink on the screen to
alert you to the problem. A conflict situation occurs when an aircraft is
too close to another aircraft, is in a restricted zone, or is in a
thunderstorm. The blinking feature can be toggled on/off by selecting
Turn Radar Sweep On/Off.

Toggle Radar Sweep

Normally, a “radar sweep” line revolves around the radar screen during
the game to simulate the realism of a radar scope. The radar sweep
can be toggled on/off with this command.
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Sound Effects

There are several sound effects which can be heard throughout the
game. Each of these effects can be toggled on or off by selecting Set
Sound Effects from the options menu. A dialog box will allow you to
select various sound effects.

Voice Options

Voice synthesis is used throughout the game to keep you abreast of
what is happening. You can choose which type of messages are
“spoken” by Selecting Set Voice Options from the Options menu.
Please note that Macintosh Il users must use System version 6.01 or
later for voice synthesis.

Icon Colors

If you are using a Macintosh Il with a color monitor, you can change
icon colors by selecting Set Icon Colors from the Options Menu. A
dialog box will present you with the images of the icons used in the
game rendered in their present colors. You may choose one of seven
available colors for each icon.

Text Options

On the Macintosh |l, game commands and events are printed in a box
below the game screen. Clicking on this text box will toggle it between
its present size to full screen size. These text messages can be
configured by selecting Set Text Options from the Options Menu.

File Menu
The “File” Menu presents these commands:

* Load Schedule

e Save Schedule

» Various Print Options
e Quit

The “Save Schedule” command saves the current schedule as a
separate document. The “Load Schedule” command loads one of
these documents as the current schedule. After you have loaded a
particular schedule, select “With Current Schedule” under the
“Simulate” menu. “Quit” ends the session of Near Miss, and returns
you to the Finder. Print Options are described later.
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Speed Menu
The speed menu presents these commands:

* Faster
* Fastest

Selecting either of these commands causes the simulation to procceed
automatically at a faster pace until you either click the mouse, or press
any key on the keyboard to resume the simulation at normal speed.
This feature is useful for playbacks, or when there is a large time
interval between the arrival of the next aircraft into your sector.

Game Playing

The career of an Air Traffic Control Specialist is filled with a high degree
of skill, professionalism and training, combined with a good measure of
stress. The controller is under stress because of the thin margin for
error combined with the large stakes of making a mistake.

In reality, operational errors, or “Deals” (as they are known to Air Traffic
Controllers), are quite rare. Fortunately, Near Miss is more forgiving
than the real thing. But it is not very forgiving.

For instance, if you cause an aircraft to crash, you immediately lose the
game. An aircraft can crash by:

¢ Mid-Air Collision

* Running Out of Fuel

* Landing Without an Approved Airport (except helicopters,
which land and score a near miss)

* Landing At An Airport From the Wrong Direction
(except helicopters, which land without penality)

 Hitting a Hill or Tower (while at an altitude that is equal to
or less than that of the obstacle)

A “near miss” event occurs when two aircraft are not separated by their
required altitude or distance spacing, (which you can vary under “Set
Options”), or when an aircraft flies through a restricted area. Near
misses substantially reduce your score.

Flying through a thunderstorm is similar to a near miss since it counts
against your score, but the penalty is much smaller than that of a near
miss.
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The Shift Clock, located to the upper right of the radar screen,
indicates the amount of time left in your shift. The Turn Timer located
at the lower right of the radar screen, counts off the 15 seconds
between turns. You can use the Turn Timer to determine how much
time remains until the next aircraft move.

The Score Display at the lower left of the radar screen shows your
current game score.

Game Scoring

Near Miss uses a sophisticated scoring algorithm to measure your skill
and performance.

Aircraft are weighted with point values that depend on the setting that
you select in the “Set Options” display. In general, as the difficulty and
realism of the simulation is increased, so is the potential score. Scoring
is based on the following formulae:

#Planes X Hazards X (Altitude + Distance Separation + 1) + 10
Points/Plane =
Time - 10

Hazards = # Hills + # Towers + Zone Value + Weather Value + # Airports X2 +
Prop Planes + Helicopters

The zone values are 0, 4, 16, 36 for none, small, medium, large. The
weather values are 0, 8, 15, for good, bad, deadly. When propeller
planes and helicopters are included their value is 7, otherwise their
value is 0.

The maximum number of points per aircraft is 4000, the minimum is 10.

When all of the aircraft have been safely dispatched, your performance
is evaluated using the following formula:

Score = Points/Plane X (#Safe Arrivals - #NearMisses/4 -#StormsFlown/10)
X (100 - Playbacks)/100

The maximum score is 240,000, which is achieved with 4000 points per
aircraft using 60 aircraft, with no playbacks, near misses, or
thunderstorms. There is no minimum score.
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Game Strategy

The fundamental objective is to maximize the number of aircraft
directed to their correct destinations. It is better to exit or land an
aircraft at a wrong destination than to have it run out of fuel and crash.
Beware of accumulating too many near misses, since they will lower
your score very quickly.

To prevent gaps in the action, click the mouse in either the small
circular Turn Timer or on the rectangular shift clock. Each click
advances the game one turn.

Printing

Near Miss enables you to print either the current Air Traffic Schedule
Panel, or the entire simulation window including the radar screen. To
print the schedule panel, select “Print Schedule” under the file menu.
To print the entire screen, select “Print Display”.

Print Poster

Near Miss incorporates a special feature that enables you to print a fun
poster on either a dot matrix or a laser printer. To print a poster, select
“Print Poster” from the file menu. Near Miss will print a poster of the
current image on the screen. The poster will print out in 20 sections
that can be pieced together.
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Important! Read Before Using

END USER LICENSE AGREEMENT
The software in this is provided to You on the condition that You agree with SIMON & SCHUSTER, INC. to the terms
and conditions set forth below. Read this End User License Agreement carefully. You will be bound by the terms of
this agreement. /f You do not agree to the terms contained in this End User License refurn the entire . along
with your . to Simon & Schuster, Inc., Software Division, One Guif + Plaza, 14th Floor, York, New

York, 10023. Att: Refunds, and your purchase will be refunded.
mgm.wmm% , nonexclusive license to use the software program and associated documentation
in this package, or any part of it Product”), subject to the following terms and conditions:

1. License
The license granted to You hereunder authorizes You to use the Licensed Product on any single computer system. A separate
gﬂmmemmﬁ%%mm End User License Agreement, is required for any other computer system on which You intend
use the :

2. Term
This End User License Agreement is effective from the date of
force until terminated. You may terminate this End User Licen mmm any time by destroying the Licensed Product
J with all copies in amy form made by You or received by You. Your right to use or copy the Licensed Product will terminate
if You fail to comply with any of the terms or conditions of this End User License Agreement. Upon such termination You shall
destroy the copies of the Licensed Product in your possession.

3. Restriction Against Transfer
This End User License Agreement, and the Licensed Product, may not be assigned, sublicensed or otherwise transferred by
You to another party unless the other party agrees to accept the terms and conditions of this End User License Agreement.
If You transfer the Licensed Product. You must at the same time either transfer all copies whether in printed or machine-readable
form to the same party or destroy any copies not transferred.
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The Licensed is copyrighted and may not be further copied without the prior written approval of S&S. Any unauthorized

mngi-sin violation of this Agreement and may also constitute a violation of the United States Copyright Law for which You
be liable in a civil or criminal suit. You may not use, transfer, modify, copy or otherwise reproduce the Licensed

Product, or any part of It, except as expressly permitted in this End User License Agreement.

Protection and Security
You shall take all reasonable steps to safeguard the Licensed Product and to ensure that no unauthorized person shall have

access 10 it and that no unauthorized copy of any part of it in any form be made.

Limited
If You are the original consumer purchaser of a diskette and it is found to be defective in materials or workmanship (which
shall not include problems relating to the nature or operation of the Licensed Product under normal use, S&S will replace it
free of charge (or, at S&S's option, refund your purchase within 30 days
30-day period, and up to one year after purchase, S&S will re any such defective diskette upon payment of a 5 ch
(or, at 5&S's option, refund your purchase price), that the Limited Warranty Registration Card has been filed with
days following the date of purchase. Any request Wmmmmmmwmm
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shall be deemed omitted and the remaining provisions shall continue in full force and effect. This End User License Agreement
is to be governed by and construed in accordance with the laws of the State of New York.



Near Miss (Macintosh)

REPLACEMENT ORDER FORM

Pisase use this form when ordering a replacement for a defective disketie,

A ¥ Ordering within Thirty Days of Purchass

¥ a disketie is reported defective within thirty days of purchase, a replacement diskette will be provided free of charge. This
card must be totally filled out and accompanied by the defective diskette and a copy of the daled shies recenpt. In addimon,
plsase complete and refurn the Limited Warranty Regisiration Card

B ¥ Ordering after Thirty Days of Purchase but within One Year

¥ a disketie is reported defective after thirty days but within one year of purchase and the Warranty Registration Card has
been properly filed, & replacement diskette will be provided 1o you for 8 nominal fee of 55.00 isend check or money order
onbyl This card must be totally filled out and accompamied by the defective diskette, a copy of the dated sales receipl, and a
85 00 check or money order made payable to Simon & Schuster, Inc.

AME PHOMNE NUMBER | )
ADDRESS
ary. STATE ZiP
PURCHASE DATE
PURCHASE PRICE

COMPUTER BRAND & MODEL
Pisase send all requests fo Product Support Canter, Simon & Schuster, Inc., Roule 8W, Englewood Clifts, NJ 07632, ATTN:
Repiacements

NOTE: Simon & Schuster reserves the right. at iis option, to refund your purchase price i heu of providing a replacement
diskere.
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Near Miss (Macintosh)
LIMITED WARRANTY REGISTRATION CARD

in prder lo preserve your rights as provided for in the limited warranty, this card must be on file with Simon & Schuster within
hirty days of purchase. Pleaze W in the information reguesied

NAME PHONE NUMBER | )

ADDRESS

ary STATE ZIp
COMPUTER BRAND & MODEL DOS VERSION MEMORY K
Whare did you purchase this product?

DEALER NAME

ADDRESS.

Ty STATE Zip
PURCHASE DATE PURCHASE PRICE

How did you learn about this preduct? (Check a3 many as applicable. |

STORE DiSPLAY ___________ SALESPERSON — _______ MAGAZINE ARTICLE___________ ADVERTISEMENT
OTHER (Please explain)

How long have you owned or used your computer?

LESS THAN J0DAYS ______ LESS THANGEMONTHS ______ _EMONTHS TOAYEAR________ OVER1YEAR

What is your primary use for the computer?

BUSINESS ______ PERSONAL________EDUCATION OTHER [Please explain)

Whare i your computer located?
FECHRE OFFACE SCHOOL OTHER |Please explain)
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Simon and Schuster Software Division
c/o College Marketing Group, Inc.

50 Cross Street

Winchester, MA 01890

ATTN: Ken Filosi



FOR ADDITIONAL HELP

If you have questions or need more help, call
our Technical Support Center.

(201) 592-2900
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